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macware® Logo Design Studio™ User Guide 
 
This guide is distributed with software that includes an end-user agreement, this 
guide, as well as the software described in it, is furnished under license and may be 
used or copied only in accordance with the terms of such license. Except as 
permitted by any such license, no part of this guide may be reproduced, stored in a 
retrieval system, or transmitted, in any form or by any other means, electronic, 
mechanical, recording, or otherwise, without the prior written permission of 
Summitsoft Corporation. Please note that the content in this guide is protected 
under copyright law even if it is not distributed with the software that includes an 
end-user agreement. The content of this guide is furnished for informational use 
only, is subject to change without notice, and should not be construed as a 
commitment by Summitsoft Corporation. Summitsoft Corporation assumes no 
responsibility or liability for any errors or inaccuracies that may appear in the 
informational content contained in this guide. 
 
Please remember that existing artwork or images that you may want to include in 
your project may be protected under copyright law. The unauthorized incorporation 
of such material into your new work could be a violation of the rights of the 
copyright owner. Please be sure to obtain any permission required form the 
copyright owner. 
 
Any references to company names in sample templates are for demonstration 
purposes only and are not intended to refer to any actual organization. 
 
 
©2005-2006 Macware Corporation. All rights reserved.  Macware, the Macware 
logo, macXware, the macXware logo, Summitsoft and the Summitsoft logo are 
either trademarks or registered trademarks of Summitsoft Corporation or Macware, 
Inc. in the United States and/or other countries. MacCapture is a trademark of 
Macware, Inc.  Apple, Mac, the Mac logo, the Made for Mac logo, Macintosh, 
QuickTime and TrueType are trademarks or registered trademarks of Apple 
Computer, Inc. in the United States and/or other countries. REAL Software, 
Incorporated. REAL Software, REALbasic and the REAL Software cube logo are 
registered trademarks of REAL Software, Inc. Other product(s), font(s), and 
company names and logos may be trademarks or registered trademarks of their 
respective companies. 
 
macware  
Omaha, Nebraska  
USA  
 
www.macXware.com 
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Welcome to Logo Design Studio 
 
Logo Design Studio gives you the power to create unlimited professional logos 
without paying for only a few concepts from overpriced design firms. 
 
Use the logo canvas window to create your logos. Display multiple canvases to 
work on more than one logo at a time. Use a ready-made template or start with a 
blank canvas. Select graphic objects, and add text and shapes and your own 
slogans and taglines, then export your logo in any of a number of formats. 
 
Registering macware products 
 
Registering your macware products is important. Registration provides you with 
timely access to the latest free product updates, technical support, valuable 
information about new product releases, access to free downloads, articles, tips 
and hints, and special offers. 
 
You can register online at www.macXware.com by clicking on the Register button 
 
Installing Logo Design Studio 
 
Insert the Logo Design Studio CD-ROM in your CD-ROM drive. Once the CD-ROM 
icon appears on the Desktop, double-click on it to launch the Welcome Screen.  
Double-click the icon that says Install Logo Design Studio to launch the installer. 
Follow the on-screen installation instructions. 
 
 
Customer Support 
 
The Internet web address for macware is www.macXware.com. You can access 
general customer service, product information, user forums, frequently asked 
questions (FAQ’s) and technical support on this website. For additional support or 
specific customer service-related questions not covered on the website, you may 
email our technical support staff. The hours of operation are 9:00 am to 5:00 pm, 
Eastern Time (EST), Monday through Friday. 
 
macware 
 
Email:   support@macxware.com 
  sales@macxware.com 
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GETTING STARTED 
 
Logo Design Studio's features are organized into a set of floating windows and palettes. The 
most important of these is the logo canvas window, on which you display your logo. The floating 
palettes let you add text and graphic elements to the logo canvas, which you can manipulate by 
using the controls on the Inspector palette. The main menu appears at the top of the screen. 
 
Creating a logo with Logo Design Studio is easy. Once you start a new logo project, you can 
create a logo using a logo template or from a blank canvas. 
 
 
STARTING FROM A TEMPLATE 
 
Initially, you may find it easier to create logos in Logo Design Studio if some of the layout work 
is done for you. The floating Logo Templates palette lets you choose from a selection of pre-
defined layouts, or templates, organized by category. 
 
Click the dropdown list at the top of the palette to display a scrolling list of the available 
template categories. Select one of the categories in the list to display the templates associated 
with it in the window below. 
 
The logo templates will appear as thumbnail graphics. To enlarge the display, slide 
the slider below the window to enlarge the thumbnails. To choose a template, click 
it. You will be asked whether you wish to open the template graphic; click Yes to 
display the template in the upper left corner of the canvas. You can then resize 
the template image to meet your needs.  
 
NOTE - You do not have to use a template within a particular category to create a logo for that 
purpose. You can use a corporate logo template to create a logo for a sports team, or a sports 
logo template for a travel logo. Template category names are for convenience only. 
 
 
STARTING FROM A BLANK CANVAS 
 
If you want to create a logo from a blank canvas, or if you have finished 
work on one logo project and want to start another, select New Logo... from the File menu. (If 
you have a logo project currently displayed, another canvas will open for your new project.) 
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ADDING LOGO ELEMENTS 
 
The Logo Objects Palette 
 
The floating Logo Objects palette lets you add graphic objects to the logo canvas. 
 
Choose one of the object types from the dropdown list in the upper 
portion of the Logo Objects palette to display the objects associated 
with it in the lower portion. Slide the slider at the bottom of the dialog to 
the right to enlarge the objects or to the left to shrink them. 
 
Double-click on an object to place it on the logo canvas. The object will 
appear full-sized, surrounded by a set of black squares. 
 
You can further manipulate the object by using the object manipulation 
tools in the Properties palette on the right pane of the work area. You 
can change the color of and add special effects to the way the object 
appears. 
 
 
Adding Text To Your Logo 
 
The Text option on the floating Tools palette lets you add text to your logo project. 
 

Click the    button on the Tools palette and move your cursor onto the logo canvas, where it 
will change to a crosshair (+). Double-click your mouse button to display the Text Effects dialog. 
Select the font for your text from the Font dropdown list and the point size from the spin box 
beside it. 
 

 
 
Select a color by clicking the color square to display the Pick a color... dialog and click the 
buttons to its right to make the text appear in bold, italics, or underlined. 
 

 
 
Enter your text in the center of the Text Effects window. Select one of the display options at the 
bottom of the dialog: Styled, Gradient, or Image Mask. 
 
If you select Gradient, select the two colors for your gradient and the direction for Color 1 to 
blend into Color 2. If you select Image Mask, select the image you want to use for as the mask 
for your text and the effects to apply to the image. 
 
Check the Horizontal checkbox to display your text flipped horizontally (reversed) in your logo 
or the Vertical checkbox to display your text flipped vertically (inverted). 
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Slide the Blur Radius slider to the right to blur the text or to the left to sharpen it. Slide the 
Transparency slider to the right to make the text more translucent or to the left to make it more 
opaque. 
 

 
 
When you are satisfied with the appearance of your text, click Apply. Your text will appear on 
the canvas, surrounded by a set of black squares that allow you to resize and move it. 
 
 
Adding Shapes And Images To Your Logo 
 
The floating Tools palette lets you add geometric shapes to your logos, as well as custom 
shapes and imported graphics. The Tools palette features a set of buttons, each of which 
corresponds to an option on the Tools menu: 
 

 Rectangle 

 
Oval (Circle) 

 
Arc 

 Line 

 Polygon 
 
Click a button and move your cursor over to the canvas, where it will change to a crosshair (+). 
Click the canvas at the point where you want to place your shape. Your cursor will change back 
to an arrow, and you will see your shape surrounded by a set of black squares. (NOTE - For a 
line, there will be only a black square at either end and a third in the center.) The black squares 
are sizing handles; place your cursor over one, hold down your mouse button, and drag to 
enlarge or reduce the shape. 
 
For the Polygon image, every time you click your mouse button, you add a vertex (corner) to 
the shape; by dragging your mouse, you move the most recently added vertex across the 
canvas while the lines connecting it to the shape lengthen or shorten as you drag. 
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You can further modify the drawing or custom image by using the options on the Properties 
palette. 
 
 
Adding Slogans and Taglines 
 
The Slogans & Taglines palette, available by selecting Insert Tagline from the File menu, lets 
you add marketing catchphrases to your logo as text that you can modify to meet your needs. 
 
Click the dropdown list at the top of the palette. Select one of the tagline categories, which will 
then display a list of examples in that category.  
 
Click one of the slogans to highlight it. To include the slogan in your logo project, double-click it 
and move your cursor to the canvas, where it will display your tagline as text that can later be 
edited and formatted the same as other text. 
 
NOTE - These slogans and taglines are general examples that you can modify to suit your 
needs. To avoid possible copyright and trademark infringement, you will need to research your 
completed slogan and/or tagline with the proper legal or government source. 
 
 
Importing Picture Images 
 
Logo Design Studio allows you to import graphic images created in other programs, or images 
such as digital photographs, into your logo project. To import an image, choose Import from the 
File menu. A standard Macintosh Open dialog appears; select an image and click Open to 
display it on the canvas. Once imported, you can resize, rotate, and move the image as you 
wish, as well as enhance it with special effects. 
 
 
Managing Multiple Logo Projects 
 
Logo Design Studio lets you work on multiple logo projects. You can create a new project for 
each logo design or company simply by opening a new canvas. Simply click the title bar on the 
canvas you want to work on and that canvas becomes the active canvas. 
 
 
MODIFYING LOGO ELEMENTS 
 
Modifying the layers of text or graphic elements added to the canvas image is done through 
many of the same dialogs used to add those elements, as well as through the Properties 
palette. 
 
 
Text and Object Manipulation Tools 
 
To change the appearance of a text or object element, use the floating Properties 
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palette. The Properties palette is divided into sections that vary according to whether the 
selected layer is a text or object element. Each section displays a set of controls to let you 
change the appearance of the selected text or object element. Some controls are common to 
both kinds of logo element, while some are available only for one or the other. 
 
In addition, the Text Effects dialog and Object Effects dialog provide further means to 
manipulate text or object elements. 
 
 
TEXT MANIPULATION TOOLS 
To change the typeface or positioning of a selected text element, click the text you wish to 
modify to display the Text Effects dialog. 
 
At the top left of the dialog is the Font dropdown list and point size spinner that let you choose 
the font name and size. At top center are buttons to set left justification (<), center justification 
(|), or right justification (>). At the top right are a set of buttons to let you display the text in 
boldface, italics, or underlined. 
 
To change the actual text, type the new text in the window in the center of the dialog. 
 
Check the Horizontal checkbox in the Flip section to flip the text horizontally, or reverse it. 
Check the Vertical checkbox to flip the text vertically, or invert it. 
 
To control how much of the layer beneath (or the background) shows through the text, slide the 
Transparency slider right or left to make the text more transparent or opaque. 
 
Additional text manipulation is available through the Properties palette. To rotate text, select 
Rotation in the Shape section and enter a new value to replace the number presently 
displayed. Text angles are oriented like a compass, with zero degrees as up/north, 90 degrees 
as right/east, 180 degrees as down/south, and 270 degrees as left/west. Enter a positive 
number to rotate the text clockwise or a negative number to rotate the text counterclockwise.  
 
You can manipulate the position of text on the canvas in the Position section of the Properties 
palette. Enter a new value for X: to move the text horizontally and a new value for Y: to move 
the text vertically. 
 

 
 
For X, higher values move the text to the right and lower values move it to the left; while for Y, 
higher values move the text downward and lower values move it upward. 
 
 
OBJECT MANIPULATION TOOLS 
To change the appearance or positioning of a selected shape or graphic object, use the 
Properties palette. The palette is divided into sections; which sections are available depend on 
whether you are manipulating a shape, an object, or text. 
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Positioning a Shape or Object: 
You can manipulate the position of a graphic element on the canvas in the Position section of 
the Properties palette. Select and enter a new value for X: to move the element horizontally and 
a new value for Y: to move the element vertically.  
 
For X, higher values move the element to the right and lower values move it to the left; while for 
Y, higher values move the element downward and lower values move it upward.) 
 
Controlling Shape Size: 
If the element is a shape other than a polygon, enter new values for Height: and Width: in the 
Dimensions section of the Properties palette.  
 

 
 
Cropping and Deforming Objects: 
Use the controls in the MaskProperties section of the Properties palette to control how much of 
an object is displayed on the canvas and how it appears. The Source Width: and Source 
Height: fields initially render the width and height of the object in pixels. Enter a new value in 
the Source Width: field lower than the original value to stretch the object horizontally; enter a 
value higher than the original value to compress it. Enter a new value in the Source Height: 
field lower than the original value to crop the top portion of the object. 
 

 
 
The Source Top: and Source Left: fields initially display values of 0. Increasing the Source 
Top: value crops an increasing amount off the top of the object as the value entered increases. 
Increasing the Source Left: value crops an increasing amount off the left side of the object as 
the value entered increases. 
 
NOTE - If either the Source Left: value equals or exceeds the Source Width: value, or the 
Source Top: value equals or exceeds the Source Height: value, the object will be cropped out 
of the canvas display. 
 
Coloring and Opacity: 
The Shape section of the Properties palette allows you to control the color, opacity, and width 
of the border around any selected shape or object, as well as the fill color and fill opacity. 
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To change the border color or fill color, click the colored ovals labeled Border Color and Fill 
Color, respectively. Select one of the color options from the Pick a color... dialog and click OK. 
The oval on the Properties palette will display the color selected, as will the element on the 
canvas. 
 
To change the border or fill opacity, select and enter new values in the Border Opacity or Fill 
Opacity fields, respectively. (The default value for each is 100, representing total opacity.) To 
change the width of a border around a shape or object, select the Border Width and enter a 
new value. The default width is 1; increase the value to thicken the border. 
 
Rotating Shapes and Objects: 
To rotate a selected shape or object, select Rotation in the Shape section and enter a new 
value to replace the number presently displayed. Rotation angles are oriented like a compass, 
with zero degrees as up/north, 90 degrees as right/east, 180 degrees as down/south, and 270 
degrees as left/west. Enter a positive number to rotate the element clockwise or a negative 
number to rotate the element counterclockwise. 
 
Three of the available shapes have their own manipulation control sections in the Properties 
palette: 
 
Circle: You can control how smooth a circle appears by changing the number of Segments: in 
the Smoothness section. The higher the number entered, the more segments will be apparent 
in drawing the circle; a value of 0.0 shows a continuous curve. 
 

 

 
 
Arc: You can define an arc's starting position and length by changing values in degrees for the 
Start Angle: and Arc Angle: in the Arc section. The higher the Arc Angle value, the longer the 
arc will appear. (The Smoothness section is also available, allowing you to control how smooth 
the arc appears.) 
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Line: You can control the curvature of a line by entering new values for Y2: and X2: in the 
Curve section of the Properties palette. 
 

 
 
 
Text and Object Color Controls 
 
Changing the color of a text or object element is accomplished through the Pick a color... 
dialog, which can be accessed through color blocks on the Text Effects dialog or colored ovals 
on the Properties palette. 
 
Select the color selection method you want from the top of the dialog. The bottom half of the 
dialog will display controls appropriate for the type of color fill you selected. For each method, 
click Apply when you are satisfied with the color at the bottom of the dialog or Cancel to 
restore the layer to its original appearance. 
 
 
RED, GREEN, AND BLUE COLOR CONTROLS 
These controls consist of three sliders that let you individually adjust the amount 
of red, green, and blue in the color you create. Below this is an area in which a 
color palette is displayed and a bar below that to display the currently selected 
color.  
 
You can control the display of the palette by choosing from Red, Green, or Blue from 
dropdown lists at the top and left of the color palette display. (You cannot select the same value 
from both lists.) 
 
Slide the Red slider to the right to increase the amount of red in your color and to the left to 
decrease the amount of red. Slide the Green slider to increase or decrease the amount of 
green and the Blue slider to increase or decrease the amount of blue. Sliding all three sliders to 
the left produces black, while sliding all 
three to the right produces white. 
 
A slider to the right of the color palette governs the lightness of the palette display itself. Slide 
the slider toward the lighter shades of the gradient to lighten the spectrum itself and toward the 
darker shades of the gradient to darken it.  
 
Select a color by clicking anywhere within the color palette. The color will appear in the color 
bar, and the Red, Green, and Blue sliders will automatically adjust to the values for that 
particular shade. 
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CYAN, MAGENTA, AND YELLOW COLOR CONTROLS 
These controls consist of three sliders that function the same way as the Red, Green, and Blue 
controls described above, except that the sliders are named Cyan, Magenta, and Yellow and 
control the amounts of those shades in the color you create. All other controls function the 
same, except as noted below. 
 
NOTE - Sliding all three sliders to the left produces white, while sliding all three to the right 
produces black. This is the opposite of how the Red, Green, and Blue option works. Red, 
green, and blue, as the primary colors of light, are additive colors; while cyan, magenta, and 
yellow, as the primary colors of pigment to printers, are subtractive colors. Additive colors are 
added together to produce white, while subtractive colors must be taken away to leave white. 
When selecting colors with this palette, you should make a test print of your logo. Although you 
are choosing colors to be printed (subtractive colors), your computer's monitor displays colors 
optimized for its screen (additive colors). 
 
 
HUE, SATURATION, AND LIGHTNESS CONTROLS 
These controls consist of three sliders that let you individually adjust the hue, saturation, and 
lightness in the color you create. Below this is an area in which a color palette is displayed and 
a bar below that to display the currently selected color.  
 
You can control the display of the color palette by choosing from Hue, Saturation, or Value 
from dropdown lists at the top and left of the palette display. (You cannot select the same value 
from both lists.) 
 
Slide the Hue slider to change the color of the selected element. Colors are arranged in a 
spectrum going from red through orange, yellow, green, blue, indigo, and violet before turning 
magenta and becoming red again. Sliding the slider to the right will change the colors going up 
the spectrum (red to orange to yellow, etc.); sliding the slider to the left will change the colors 
going down the spectrum (red to purple to blue, etc.). When the slider is moved all the way to 
the left or right, the element will revert to its original color. 
 
Slide the Saturation slider to the left to make the color appear more "washed out"; sliding the 
slider all the way to the left will make a colored object appear gray. Slide the slider to the right to 
make the color appear more vibrant. 
 
Slide the Lightness slider to the left to make the color appear darker; sliding the slider all the 
way to the left will make the element appear black. Slide the slider to the right to make the color 
appear lighter; sliding the slider all the way to the right will make the object appear white. 
 
A slider to the right of the color palette controls the brightness of the palette display itself. Slide 
the slider toward the lighter shades of the gradient to lighten the spectrum itself and toward the 
darker shades of the gradient to darken it. 
 
Select a color by clicking anywhere within the color palette. The color will appear in the color 
bar, and the Hue, Saturation, and Lightness sliders will automatically adjust to the values for 
that particular shade. 
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COLOR SPECTRUM CONTROLS 
For this option, a color spectrum appears in the left center of the dialog, with red on the left and 
progressing through the other colors (orange, yellow, green, blue, indigo, and violet) before 
returning to red again on the far right. 
 
Move your cursor over the spectrum. Click your mouse to display the color at the cursor in the 
color bar at the bottom of the dialog. To the right, the Red, Green, and Blue color values for 
web colors; the Cyan, Magenta, and Yellow values for printed colors; and the Hue, Saturation, 
and Lightness values are displayed. 
 
 
COLOR CHARTS 
You can select one of two charts: Color Chart - Basic or Color Chart - Metallic. Both pages 
feature a color grid, with the Metallic grid featuring more color choices than the Basic grid. 
When you drag your cursor over a color and click, the color bar at the bottom of the dialog will 
display the color you selected. 
 
 
BRIGHTNESS AND CONTRAST COLOR CONTROLS 
These controls consist of two sliders labeled Brightness and Contrast, with a colored area 
below the sliders and a color bar at the bottom of the dialog that display the currently selected 
color. 
 
Slide the Brightness slider to the right to make the image appear brighter or left to make it 
appear darker. Slide the Contrast slider to the right to make the image stand out more and left 
to make the image less distinct. 
 
Click anywhere within the colored area to display the Macintosh Colors dialog, which offers 
several color-picking options. When the color in the color bar at the top of the dialog is what you 
want, click OK, and the colored area and color bar in the Pick a color... dialog will display that 
color. 
 
NOTE - You can often get the sharpest images by sliding the Brightness slider all the way to the 
left and the Contrast slider all the way to the right. 
 
 
Text and Object Effect Controls 
 
You can apply a number of special effects the text or object elements in your logo. You can 
apply special effects to text through the Text Effects dialog, and you can apply special effects 
to objects through the Object effects dialog. You can also apply other effects to both text and 
objects through the Properties palette. 
 
 
TEXT EFFECT CONTROLS 
Click the text on your logo you want to modify to display the Text Effects dialog; your text 
appears in the center window. 
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You can choose whether you want to have your text Styled (the default option), display colors 
in a Gradient, or use an Image mask to display your text by clicking the corresponding option 
in the lower left of the dialog. 
 

 
 
If you choose the Gradient option, click the Color 1 and Color 2 boxes in the Gradient section 
to select the colors you want to transition between from the Pick a color... dialog. You can 
choose the direction in which Color 1 transitions into Color 2 by clicking the appropriate radio 
button in the ring of buttons to the right of the color boxes. 
 

 
 
NOTE - To make the text a single color, click the color box in the upper right corner of the dialog 
instead. 
 
If you choose the Image mask option, click the Image window in the bottom center of the dialog 
to select an image from the Open dialog. After you select the image you want, click Open to 
open the Object effects dialog and manipulate the image. When you are satisfied with the 
image, click Apply; a thumbnail of the image will display in the Image window. 
 
Use the Blur Radius slider to control how sharp or blurred the text appears. Slide the slider to 
the right to blur the text; slide it to the left to sharpen it. 
 
 
OBJECT EFFECT CONTROLS 
You apply special effects to a graphic object in your logo project through the Object effects 
dialog. To display the dialog, click an object in your logo project once to select it (it will be 
surrounded by black squares), then a second time to display the Object effects dialog. 
 
The object is displayed, enlarged, in the window on the left of the dialog. The right half displays 
a dropdown list of effects, below which is a checkbox labeled with the corresponding effect and 
one or more controls, depending on the effect chosen. 
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Choose the effect you wish to apply to the object from the dropdown list and check the 
checkbox below it to enable the effect (e.g., Grayscale, Invert, or Transparent) or its 
governing controls. Controls can be in the form of option buttons, checkboxes (Flip, Flip 
Colors), color boxes (Replace Color, Tint), dropdown lists and spin boxes (Posterize), sliders, 
or a combination of controls. 
 

• If your effect uses option buttons, click the button in front of the option for the kind of 
effect you wish to apply. (You may need to make additional selections, based on the 
option you choose.) 

• If your effect uses checkboxes, check the boxes for those components of the effect 
you wish to apply. 

• If your effect uses color boxes, click the boxes for the color(s) you wish to change and 
select your new color from the Pick a color... dialog. 

• If your effect uses a dropdown list or spin box, select the value you wish from the list. 
• If your effect uses one or more sliders, slide the slider to the right to increase the effect 

or to the left to decrease the effect. 
 
You may apply more than one effect at a time. To apply another effect, select it from the 
dropdown list and check the checkbox labeled with the new effect's name. If you wish to 
remove an effect, select the effect you wish to remove from the dropdown list and uncheck the 
checkbox. 
 
You can see the effects of your changes by clicking Preview to see the effect(s) on the object 
in the dialog window. If you are satisfied with the results, click Apply to apply the effects to the 
object in your logo project, or click Cancel to leave the object alone. 
 
 
Manipulating Layers 
 
Logo Design Studio places each element on the canvas into its own layer. You can drag layers 
around the canvas, move them with the arrow keys, or place them above or beneath other 
layers. When one layer is dragged over another layer's position, by default it is placed on top 
that layer. 
 
You can group or ungroup layers as you wish. You can hide, display, or change the stacking of 
layers by using the Layers palette. You can change the size and position of layers by using the 
sizing handles around layers. 
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All of the layers on the canvas are listed in the Layers palette. You can select one of the other 
layers by double-clicking its name in the table; the new layer's name will then appear 
highlighted, and the corresponding element on the canvas will be surrounded by a group of 
black squares. 
 
 
HIDING AND DISPLAYING LAYERS 
If you're not sure how many of the elements you've assembled into your logo should be there, 
Logo Design Studio lets you hide layers from the display to see what the logo looks like without 
them. Then, if you decide you do want those layers as part of the logo after all, you can unhide 
them so that they display again. 
 
To hide a selected layer, either select Hide from the Edit menu or uncheck the box for that 
layer on the Layers palette.  The layer will disappear from the canvas display, but will still be 
part of the logo project. To hide multiple layers at once, uncheck the box on the Layers palette 
in front of each layer to be hidden. The corresponding layers will disappear from the canvas 
display while remaining part of the logo project. 
 
To display a hidden layer, either select Unhide from the Edit menu or check the box for that 
layer on the Layers palette. The hidden layer will once again display on the canvas. To display 
multiple hidden layers at once, check the box on the Layers dialog in front of each layer to be 
displayed. The corresponding layers will reappear on the canvas display. 
 
NOTE - This only hides the display of the layers; it does not delete any of them from your 
project. 
 
 
REARRANGING LAYERS 
To change the position of the selected layer with respect to the other layers, click 
the Up or Down arrows at the bottom of the Layers palette to move the selected layer up or 
down in the list. If the layers are positioned over one another on the canvas, the Up arrow will 
place the layer on top of the layers listed beneath it, and the Down arrow will place the layer 
below those listed above it. 
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GROUPING AND UNGROUPING LAYERS 
Logo Design Studio lets you group layers into a unit to move or resize together and then 
ungroup them to manipulate individually again. 
 

You select layers to be grouped by clicking the   (caret) button on the Tools palette. A 
green rectangle appears on the canvas when you drag your cursor over it. Each layer that you 
enclose in the selection area displays a set of black squares (sizing handles) around it. 
 
To group the selected layers into a unit, select Group from the Edit menu. The sizing handles 
around the individual layers will be replaced with a single set of sizing handles that 
encompasses all the layers in the group, and the Layers palette will list the group name in place 
of the individual layer names. The group can now be resized, rotated, and moved as a unit. 
 
NOTE - You can also bundle smaller groups into larger groups or add individual layers to 
existing groups to make new groups. Simply select the groups and select Group from the Edit 
menu. 
 
To unbundle a group into its components, select Ungroup from the Edit menu. The single set 
of sizing handles will be replaced with individual sizing handles around the component layers, 
and the Layers dialog will again list the individual component names. To take away the sizing 
handles around individual layers, click the canvas anywhere other than where a layer appears. 
 
 
RESIZING AND ROTATING LAYERS 
You resize a layer by using its sizing handles. To display the sizing handles for a layer, click 
that layer to select it. The text or object will be surrounded by a group of black squares. (You 
will also see these dots when you initially add most types of text or objects to the canvas.)  
 

 

 

 
 
To stretch a layer, hold down your mouse button and drag the cursor away from the layer's 
center; to condense a layer, drag the cursor toward the object's center. To enlarge or shrink a 
layer proportionately, hold down your Shift key while dragging. 
 
NOTE - You can enlarge or shrink an object proportionately after stretching or condensing it, or 
stretch or condense an object after enlarging or shrinking it proportionately. 
 
Some sizing handles work differently, however: A polygon is surrounded by as many sizing 
handles as it has vertices. Drag one sizing handle toward or away from the center of the 
polygon to lengthen or shorten the line segments connected to that vertex. A line is surrounded 
by only two sizing handles. Drag one end square toward or away from the center square to 
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shorten or lengthen the line. Drag one end square perpendicular to the other end square to 
change the angle at which the line displays. 
 
When you move your cursor over the layer itself, by holding down your mouse button, you can 
drag the layer anywhere on the canvas when you move your mouse in a corresponding 
direction. 
 
To rotate a selected layer, click the Rotation option on the Shape section of the Properties 
palette. The numeric field will appear highlighted; enter a new value to replace the value 
currently displayed. Enter a positive value, or increase the current value, to rotate the layer 
clockwise; enter a negative value, or decrease the current value, to rotate the layer 
counterclockwise. 
 
 
ARROW KEY CONTROLS 
Logo Design Studio enables your keyboard arrow keys to manipulate text, shapes, and objects 
on the canvas. You can move text and object layers using your arrow keys alone or in 
conjunction with the Shift keys. Below is a list of movement functions using the arrow keys: 
 
Arrow Key Or Combination Function 
Left-arrow Moves selected layer leftward on the canvas 

about 50 pixels. 
Shift+Left-arrow 
 
 

Moves selected layer leftward on the canvas 
about 400-450 pixels (8-10 times further). 

Right-arrow Moves selected layer rightward on the canvas 
about 50 pixels. 

Shift+Right-arrow Moves selected layer rightward on the canvas 
about 400-450 pixels (8-10 times further). 

Up-arrow Moves selected layer upward on the canvas about 
50 pixels. 

Shift+Up-arrow Moves selected layer upward on the canvas about 
400-450 pixels (8-10 times further). 

Down-arrow Moves selected layer downward on the canvas 
about 50 pixels. 

Shift+Down arrow Moves selected layer downward on the canvas 
about 400-450 pixels (8-10 times further). 

 
 
Additional Work Area Controls 
 
Logo Design Studio offers additional features to make it easier to work on your logo projects. 
The canvas features rulers that let you scale your logos in one of three measurement systems 
and a grid that can be turned on and off to help place your layers. You can also change the 
canvas itself after starting your project if you need to or zoom in and out as necessary to 
examine your logo in detail. 
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THE CANVAS RULERS 
The Logo Design Studio canvas displays rulers at the top and left that allow you to scale the 
elements of your project. As you move your cursor over the canvas, you can read its horizontal 
and vertical position from the lines that move along the rulers correspondingly. You can set the 
rulers to display in one of three units: inches, centimeters, or millimeters. 
 

 
 
To change the unit of display, select Rulers in the Logo Canvas section of the Properties 
palette and select Inches, Centimeters, or Millimeters. The scales on the rulers will change as 
the unit of measurement changes. 
 
 
THE CANVAS GRID 
The canvas grid provides a guide to place layers for your logo so that they line up properly with 
respect to each other. To turn on the grid, check the Show Grid checkbox in the Logo Canvas 
section of the Properties palette. Uncheck the box to turn off the grid. 
 
To change the color of the grid, click the Grid Color oval and select one of the options from the 
Pick a color... dialog. Your new color will display in the oval after being selected, and the 
canvas grid will display in the same color. 
 
 
RESIZING THE CANVAS 
You can resize the logo canvas in one of two ways: 
 
Click the green Maximize button in the upper left of the canvas window to enlarge the window to 
large the canvas to its maximum size. Click the button again to return the canvas to its previous 
smaller size. 
 
To resize the canvas more precisely, place your cursor over the sizing handle (three diagonal 
slashes) at the bottom right of the canvas window. Drag the handle away from the canvas 
center to enlarge the canvas or toward the center to shrink the canvas. (Drag horizontally to 
stretch or condense the canvas horizontally; drag vertically to stretch or condense it vertically; 
and drag diagonally to change both dimensions at once.) 
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CHANGING THE CANVAS BACKGROUND 
Choose the type of background from the Background Type dropdown list in the Logo Canvas 
section of the Properties palette. Choose Transparent to display a checkerboard pattern on the 
canvas; this background will not be part of the logo, but areas on the logo where this pattern 
shows through shows where the logo itself will be transparent. Choose Fill to display a solid 
color backdrop for the canvas, and choose Image to display a graphic image of your choice as 
the backdrop. 
 

 
 
If you select either Transparent or Fill, click the Background Color oval to change the 
background color or contrasting block color in the checkerboard pattern using the Pick a 
color... dialog. If you select Transparent, choose the size of the blocks in the checkerboard 
backdrop from the Transparent Block Size dropdown list: Small, Medium, Large, or Huge. 
 
 
If you select Image, choose the image by clicking the Background Image rectangle, which will 
display a thumbnail of the image you select. Select the method of placement from the Image 
Placement dropdown list: select Stretch to stretch the image, Proportional to display its 
proportional height and width on the canvas, Tile to display multiple images on the canvas, 
Crop to display only a selected portion of the image, or Center to center it on the canvas. 
 
 
CHANGING THE APPEARANCE OF SELECTED OBJECTS 
In the Object Select section of the Properties palette, click the Pointed Object Color oval to 
change the color in which objects pointed to are displayed in or the Selected Object Color oval 
to change the color in which selected objects are displayed on the canvas. Choose your color 
from the Pick a color... dialog and click Apply to apply the new color. 
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CHANGING THE MARQUEE APPEARANCE 
In the Marquee Select section of the Properties palette, click the Marquee Border Opacity and 
Marquee Border Width fields and enter new values in those fields to control how opaque and 
how wide the marquee border appears. Click the Marquee Border Color oval to change the 
marquee border's color using the Pick a color... dialog. 
 

 
 
Click the Marquee Fill Opacity field and enter a new value to change how opaque the 
marquee itself is. 
 
 
ZOOMING IN AND OUT 
Select Zoom In on the View menu to bring the canvas closer. Select Zoom Out to make the 
canvas appear further away. 
 
 
SAVING YOUR LOGO 
 
To save your logo at any time, choose Save or Save As from the File menu. (Use Save As the 
first time you save your logo and Save thereafter.) 
 
The Save dialog will be displayed. Enter the name to save your logo project under in the Save 
As field. Click the arrow to the right of the field to display a list of folders and select the folder 
you want to save the file to from within the list, or navigate to the folder using the Where 
dropdown list. 
 
Click Save to save the logo, or Cancel to abort the save. 
 
 
EXPORTING YOUR LOGO 
 
The Logo Export Process 
 
Logos created in Logo Design Studio can be exported in a variety of formats. To export your 
logo, select Export Logo from the File menu to display the Export dialog. 
 
Select the resolution (in dots per inch) from the Resolution dropdown list. (A value of "72" is 
recommended for most logos intended for Web display, while a value of "300" is recommended 
for most printed logos.) Click Export to display the Export Image As dialog. 
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Enter the name for your exported logo in the Save As field. Click the arrow to the right of the 
field to display a list of folders and select the folder you want to save the file to from within the 
list, or navigate to the folder using the Where dropdown list. 
 
Select the graphic format for your exported logo in the Format dropdown list. For most formats, 
the Options button to the right of the list will be active; click it to select options specific to the 
graphic format for your exported logo. 
 
Click Save to export the file in the format you chose or Cancel to abort the export. 
 
NOTE - Your original logo project file will remain unchanged after the export. You can export 
additional logos in different graphic formats from it, and you can also save your logo project file 
under a different name to create a new logo project. 
 
 
Logo Export Formats 
 
Logo Design Studio lets you export your logo in any of the formats listed below. For specific 
information about the format and option controls associated with that format, see the program’s 
help file. 
 

• Windows Bitmap Format 
• JPEG Image Format 
• JPEG 2000 Image Format 
• MacPaint Format 
• Photoshop Format 
• PICT File Format 
• PNG Image Format 
• QuickTime Image Format 
• SGI Image Format 
• TGA Image Format 
• TIFF Image Format 

 
 
NEED SOME MORE HELP? 
 
The Logo Design Studio help file provides a ready source of information about the product. You 
can access the help file by selecting LDSMac Help… from the Help menu. 
 
Further help can be found on the macware website at: 
 
http://macxware.com/ 
 
You can view frequently asked questions (FAQs) or visit the macware forums from the support 
section of the macware website. For questions that aren’t answered on the website, please 
contact: 
 
support@macXware.com 
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